Enterprise Reporting

Advanced Web Intelligence Training
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 – Overview</td>
<td>4</td>
</tr>
<tr>
<td>2 – Web Intelligence Access</td>
<td>8</td>
</tr>
<tr>
<td>3 – BI Launch Pad Navigation</td>
<td>12</td>
</tr>
<tr>
<td>4 – Nested Query Filter</td>
<td>17</td>
</tr>
<tr>
<td>5 – Working with Report Tables</td>
<td>29</td>
</tr>
<tr>
<td>6 – Data Tracking</td>
<td>34</td>
</tr>
<tr>
<td>7 – On-Report Filtering</td>
<td>39</td>
</tr>
<tr>
<td>8 – Formulas and Variables</td>
<td>53</td>
</tr>
<tr>
<td>9 – Working with Multiple Queries</td>
<td>62</td>
</tr>
<tr>
<td>10 – Printing and Exporting Reports</td>
<td>84</td>
</tr>
<tr>
<td>11 – Scheduling Reports</td>
<td>91</td>
</tr>
<tr>
<td>12 – Log off</td>
<td>97</td>
</tr>
</tbody>
</table>
• Your name?
• Your agency?
• How have you been using ER Web Intelligence?
Chapter 1

Overview
At the conclusion of class participants should have an understanding of these Web Intelligence features:

- Nested Queries
- Working w/ Report Tables
- On-Report Filtering
- Working with Multiple Queries
- Data Tracking
- Creating Variables
- Merge Dimensions
- Scheduling Reports
ER Hours of Operation

- 24/7 for viewing reports
- Daily AFRS Data updates are from 8 pm through Midnight – New and existing AFRS queries cannot be generated during this time

System Maintenance – Between 7pm Sat to 7:30 am Sun, either the 1st or the 2nd week of every month

Getting Support

- 8:00 a.m. to 5:00 p.m. Monday through Friday
- 360.407.9100
- support@watech.wa.gov
SAP Business Objects Web Intelligence Product Tutorials

http://scn.sap.com/docs/DOC-7819
Chapter 2

Web Intelligence Access
Web Intelligence customers must have online access either through the State Governmental Network (SGN) or through Secure Access WA (SAW) for use from outside of the state firewall.

This guide only includes information for access within the SGN.

For access using SAW please consult the instructions at:
http://watech.wa.gov/sites/default/files/BO_4.0_SAW_Instructions.pdf
Type [https://reporting.des.wa.gov](https://reporting.des.wa.gov) into the address bar of your internet browser and click Go, or press [Enter].

1. Enter your assigned User Name in the **User Name** field.
2. Enter your Password in the **Password** field.
   - This application requires a hardened password. Refer to the password guidelines on the next page.
3. Click the **Log On** button to initiate a connection to the Web Intelligence.
The hardened password criteria is as follows:

- Password must be at least eight characters long.
- Password must contain the following character classes: upper case letters, lower case letters, numerals, and special characters.
- It cannot contain your logon ID.
- Password must be changed every 90 days.
- After five incorrect logon attempts, your user account will be locked.
Chapter 3

BI Launch Pad Navigation
The “Home” tab allows for quick access to:
1. Recently Viewed Reports
2. Unread Business Objects Inbox Items
3. Recently Run Reports
4. Unread Alerts (Currently not in use)
5. Applications
The “Documents” tab allows access to
- My Documents – Access to personal documents. Other users will not have access to these documents.
- Folders – Access to Agency and other public folders.
- Personal Categories – Allows users to group reports that are used frequently together regardless of their folder.
- Search – Allow users to search for documents and objects stored in Web Intelligence.
Viewing Existing Documents

The BI Launch Pad allows for the viewing of existing Web Intelligence Reports. To view existing Web Intelligence Report:

1. Click on the report in the Recently Viewed or Recently Run lists on the “Home” tab or select the “Documents” tab.
2. Select the correct folder where you need to view your report (s). In this example, we are looking in “My Documents” and “My Favorites”.
3. Right Click on the report you wish to view and from the menu, select “View”.

![Image of BI Launch Pad with steps highlighted for viewing existing documents]
Viewing Existing Documents

4. The report will open in view mode.
5. To navigate, you can scroll up and down or left and right, and advance pages using the page navigation controls located on the bottom of the page.
Chapter 4

Nested Query Filter
1. To create a new Web Intelligence document, click on the **Web Intelligence** icon in the **My Applications** panel.
Creating New Web Intelligence Document

2. Click on **New** in the Web Intelligence Toolbar
3. Select *Universe*, and click *OK*. 
4. Select a universe. If a default universe is proposed, you can use this universe or select a different universe.
5. Click **Select**
Nesting query filters allows you to create more complex filter conditions than is possible when you combine filters at the same level. To create a nested query filter follow the following steps.

1. Build the following query.
2. Select the field you want to nest and drag it over the field you wish to nest it with. Make sure that your cursor is directly over the original filter.
3. The query should look similar to this.
4. Define the query value.
5. Click the indented **And** to make it an **Or**. Then run your query.
Nested query filters can be set on any field and can be used to combine different data elements (see example below).
The left most ‘And’ should not be changed to an ‘Or’. In the example below you would receive:

- All data for agency 163 and
- All Data for Fiscal Months 1 – 12 from all GLs, programs and agencies and
- All Data for GLs 6505;6510;6560 from all agencies, fiscal months, and programs and
- All data for Program 020 from all agencies, time periods, or GLs.
Chapter 5

Working with Report Tables
A break divides a large table into smaller sub-tables based on a selected dimension value. Using a break, you can display subtotals by the specified value, as well as a grand total for all values. The data is automatically sorted in ascending order by the dimension values when a break is inserted.

To add a break, click in the data to highlight the column. Click on the Break button on Analysis/Display sub tab to add and remove a break.
Creating Sections

Sections allow you to split report information into smaller, more comprehensible parts.

You can create a single section or include multiple sections with subsections in a report. You can also remove and reposition sections within a report.

You cannot use a measure to create a section.

Use the following steps to create sections in a report.

1. Select the data portion of the data object you wish to use as your section.
Creating Sections

2. Right click on the data element and select **Set as Section** from the context menu.
3. The report will now be displayed in sections based on the data element selected.

### 010

<table>
<thead>
<tr>
<th>Biennium</th>
<th>Gl. Account</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>2017</td>
<td>6505</td>
<td>633,569.47</td>
</tr>
<tr>
<td>2017</td>
<td>6510</td>
<td>16,820,970.05</td>
</tr>
</tbody>
</table>

### 030

<table>
<thead>
<tr>
<th>Biennium</th>
<th>Gl. Account</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>2017</td>
<td>6505</td>
<td>3,819,610.11</td>
</tr>
<tr>
<td>2017</td>
<td>6510</td>
<td>39,945,045.27</td>
</tr>
</tbody>
</table>

### 040
Chapter 6

Data Tracking
Web Intelligence allows you to track and display data changes to help you focus your analysis on key areas.

When you track data changes, you select a particular data refresh as a reference point. This data is known as the reference data. When you display the data changes, Web Intelligence places your current data in context by showing how it relates to the reference data.

Web Intelligence allows you to track the following types of data change:

- Added data
- Modified data
- Decreased data
- Removed data
- Increased data
1. To activate data tracking click on **Track Changes** on the bottom of the screen.
2. When the Data Tracking window opens select whether to compare with last data refresh or with a certain date in time.

   Compare with last data refresh  
   The current data becomes the reference data after each data refresh. The report always shows the difference between the most recent data and the data before the last refresh.

   Compare with data refresh from:  
   The current data becomes the fixed reference data and remains the reference data after further data refreshes. The report always shows the difference between the most recent data and this fixed reference data.

3. Select which reports to have data tracking.
4. Select whether to refresh now.
5. When the data is refreshed it will automatically show the where the changes in the data are.

<table>
<thead>
<tr>
<th>Biennium</th>
<th>GL Account</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>2013</td>
<td>6505</td>
<td>$433,186.37</td>
</tr>
<tr>
<td>2013</td>
<td>6510</td>
<td>$39,894,424.87</td>
</tr>
<tr>
<td>2013</td>
<td>6511</td>
<td>$5,188,492.70</td>
</tr>
<tr>
<td>2013</td>
<td>6515</td>
<td>$48,174,698.43</td>
</tr>
<tr>
<td>2013</td>
<td>6525</td>
<td>$14,003,381,443</td>
</tr>
<tr>
<td>Sum:</td>
<td></td>
<td>$3,627,274.54</td>
</tr>
</tbody>
</table>

6. Track changes can be toggled to display or not by clicking on the **Show Changes** button located under the **Analysis** tab and **Data Tracking** sub-tab.
You can filter reports to limit the results that are displayed to specific information that interests you. The data you filter out remains within the Web Intelligence document; it is simply not displayed in the report tables or charts. This means you can change or remove report filters in order to view the hidden values, without modifying the query definition behind the document.

You can apply different filters to different parts of a report. For example, you can limit the results in the entire report to a specific dimension value and then limit results in a table or chart further to focus on results for a different dimension.

You can include multiple filters in a report.
You can apply filters at two levels within a document:

- **Query filters** – these filters are defined on the query; they limit the data retrieved from the data source and returned to the Web Intelligence document.
- **Report filters** – these filters limit the values displayed on reports, tables, charts, sections within the document, but they don’t modify the data that is retrieved from the data source; they simply hide values at the report level.
The report filter bar allows for the addition of multiple single value report filters to a report.

1. Click on the **Analysis** tab and on the Interact tab select **Filter Bar**
2. The **Report Filter Bar** will open under the **Formula Tool Bar**.

3. Click on the filter icon at the front of the **Report Filter Bar** and select the dimension to filter on.
4. Select a value in the selected dimension to filter the report.
1. To set a filter on a table, select the column with the data to be filtered by clicking in the data.
2. Under the **Analysis** tab on the **Filters** sub-tab click drop down arrow to select **Add Filter**.
3. When the Report Filter box opens type the value(s) you want to retrieve in the box, or select the value(s) you want to retrieve from the displayed List of Values and add them to the Selected Values box by clicking the > button. Then click OK.
4. The report will now be filtered by the values selected.

Filters can be edited by clicking on the column that contains the filter and selecting "edit filter" from the Filter drop down list.
Report filters can be viewed by clicking on the **Document Structure and Filters** button in the list of icons along the left side of the screen. Filters will be displayed with a gold funnel icon.
Input controls provide a convenient, easily-accessible method for filtering and analyzing report data. You define input controls using standard windows controls such as text boxes and radio buttons. You associate these controls with report elements such as tables or section headers, and use the controls to filter the data in the report elements. When you select values in the input control, Web Intelligence filters the values in the associated report elements. To add an input control follow these steps.

1. Select the column with the data to be filtered by clicking in the data.
2. Under the **Analysis** tab and **Filters** sub-tab click the **Controls** button.
3. In the **Define Input Control** box check to make sure the right dimension is selected and click **Next**.

4. Select the type of input control to add and set the options. Then click **Next**.
   - There is a description of the combo box type in the top right corner of the Define Input Control box.
5. Select the report elements to assign the input control to. Input Controls can be assigned to the entire report(s) or certain elements.

6. Click **Finish**.
7. You can now use the Input Control to filter your report. Input Controls can be accessed by clicking on the **Input Controls** icon along the left side of the screen.
Chapter 8

Formulas and Variables
**Formulas** are custom calculations allowing additional calculations beyond the base objects and standard calculations.

**Variables** are formulas or syntax statements that have been assigned a name. Variables can be used in tables and formulas in exactly the same way as other report objects. Variables appear in the formula editor under the Variables folder.

Variables can be used to simplify complex formulas by breaking a complex formula down into manageable parts and making it much easier to read, as well as making building formulas much less error-prone.
How to create a Concatenation Formula.

1. Click on the first object to be concatenated.
2. Click the Formula Editor button in the Formula Bar.
3. Click in the Formula box after the title of the dimension.
4. Then add this value after the first object:
   + “ / “ +
5. Then double click the next object to be added from the Available Objects list.
(See Next Page)
Create a Formula

Formula Editor

Formula:

\[-[\text{GL Account}] + \text{/} +[\text{GL Account Title}]\]

Available Objects:
- GL Account
- GL Account Title
- Program
- Amount
- Variables

Available Functions:
- Aggregate
- Average
- Count
- First
- Interpolation
- Last
- Filter
- Median
- Min
- Mode

Available Operators:
- =
- <
- <=
- >
- >=
- +
- -
- /
- *
- ( )

Description:
- GL Account Title

OK  Cancel
7. Click the green check mark to validate the formula.

8. If the formula is correct **The formula is correct** will be displayed under the **Formula** box.

9. Once the formula is correct click **OK**. The new value will now be displayed in the column.
1. Click on the data in the column that contains the formula to be turned into a variable.
2. In the **Formula Tool Bar** click the **Create Variable** button.
3. In the **Create Variable** window assign the Variable a name.
4. Click **OK**.
5. The variable is now ready for use in another report or variable.
1. Click on the **Data Access** tab. Under the **Data Objects** click on **New Variable**.

![Image of Data Access and Data Objects tabs]

2. Assign the new variable a title in the **Name** box.
3. Click in the **Formula** box.
4. In the **Available Objects** double click the first object to be added.
5. Then add this value after the first object:
   
   ```
   + " / " +
   ```
6. Then double click the next object to be added from the **Available Objects** list.
7. Click the green check mark to validate the formula.

8. If the formula is correct **The formula is correct** will be displayed under the **Formula** box.

9. Once the formula is correct click **OK**. The new variable will now be displayed under **Available Objects**.
AFRS Variables – Examples

Approved and Adjusted Allotment Variables

- Budget Option 1
  - \(=\text{Sum(If([GL Account] \text{InList} \("0621","0623","0622","6210"); [Amount];0))}\)

- Budget Option 2 w/ FTE’s
  - \(=\text{Sum(If([GL Account] \text{InList} \("0622","6210");[Amount];0))}\)

Cash, Accrual Encumbrance Variable

- Cash, Accr(all), Encum
  - \(=\text{Sum(If([GL Account] \text{InList} \("6505","6510","6560","6410");[Amount];0))}\)

Revenue Variable

- Cash Accr(all)
  - \(=\text{Sum(If([GL Account] \text{InList} \("3205","3210","3260");[GL Amount];0))}\)
Chapter 9

Working with Multiple Queries
You can include one or multiple queries in a document. These queries can be based on any supported data source.

Defining multiple queries in a single document is necessary when the data you want to include in a document is available in multiple data sources, or when you want to create several differently-focused queries on the same data source.

You can define multiple queries when you build a new document or add more queries to an existing document. You can present the information from all of the queries on a single report or on multiple reports in the same document.
You must run the query first before you are allowed to duplicate the query.

If you want to build a different query on a universe already included in the document, you can duplicate the existing query on that universe and then modify it, instead of starting from scratch.

Duplicated Queries always use the same data source as the query they were duplicated from, but can be updated to use a different source.
1. After opening the Web Intelligence document click on the **Data Access** Tab.

2. On the Data Providers sub-tab click **Edit**.
3. Select the query to duplicate by right-clicking on the **Query** tab at the bottom of the report panel.
4. Select **Run Queries**

5. When the Add Query box appears select one of the three choices
6. The data will be displayed based the selection.

<table>
<thead>
<tr>
<th>Display Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert a table in a new report</td>
<td>Display the data on a new report in the document</td>
</tr>
<tr>
<td>Insert a table in the current report</td>
<td>Display the data on the currently selected report in a new table</td>
</tr>
<tr>
<td>Include the result objects in the document</td>
<td>Include the data in the document without displaying the data on a report.</td>
</tr>
<tr>
<td>without generating a table</td>
<td>(You can add the objects returned by the query to the report later.)</td>
</tr>
</tbody>
</table>
7. Once the report opens click on the **Data Access** tab, then click on the **Tools** sub-tab.
8. Click on **Change Source** and select the query to change.
Duplicate a Query

9. In the Change Source Wizard window select **Specify a new data source** and select **Universe** from the drop down list.

10. When the list of universes opens double click the new universe.

11. Then Click **Next**.
12. When the **Object Mapping** screen opens click Finish.

13. When the query pane opens rerun your queries.
Follow these steps to add an additional query to a document:

1. After opening the Web Intelligence document click on the **Data Access** Tab.

2. On the Data Providers sub-tab click **Edit**.
3. Click on **Add Query** in the top left.

4. Select **From Universe**.

5. Select the **Universe** for the new query.

6. Add **Result Objects** and **Query Filters** to the new query and click **Run Queries**.
7. When the Add Query box appears select one of the three choices

   ![Add Query Pop-up]

   Choose how you want to include the data from the new query.

   - Insert a table in a new report
   - Insert a table in the current report
   - Include the result objects in the document without generating a table

   OK
<table>
<thead>
<tr>
<th>Display Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert a table in a new report</td>
<td>Display the data on a new report in the document</td>
</tr>
<tr>
<td>Insert a table in the current report</td>
<td>Display the data on the currently selected report in a new table</td>
</tr>
<tr>
<td>Include the result objects in the document</td>
<td>Include the data in the document without displaying the data on a report.</td>
</tr>
<tr>
<td></td>
<td>(You can add the objects returned by the query to the report later.)</td>
</tr>
</tbody>
</table>

8. The data will be displayed based on the selection.
### Rename Queries

The query name can be changed by right clicking the query on the query tab and selecting **Edit Name** from the menu, then typing a new name in the **New Value** box in the dialog box that appears.

### Move Queries

The order of queries can be changed by right clicking on the query tab and selecting **Move** from the menu, then selecting **Right** or **Left** to move it in that direction.

### Delete Queries

Queries can be deleted by right clicking on the query tab and selecting **Delete** from the menu. Click **Yes** on the warning to continue with the deletion or **No** to cancel.
Web Intelligence allows you to synchronize data from multiple queries or data providers by merging dimension objects.

Merging dimensions is the only way to combine data from different data sources in a report.

Rules when merging dimensions

- Only dimensions defined in the universe can be merged. You cannot merge variables.
- Objects must have the same data type. You cannot merge a number with a string, even if the values match.
- Any number of queries can be merged. There is no limit.
- Any number of dimension objects can be merged between two queries. Again, no limit.
- Values are case-sensitive. So, if the values are the same, but of different case, they will not match. They will be shown as different values.
- Measures can not be merged. Measures must be calculated with a formula or variable.
When two queries have been successfully ran to merge dimension together follow these steps:

1. On the **Data Access** tab and **Data Objects** sub-tab click **Merge**.

   ![Data Access Tab and Data Objects Sub-tab](Image)

   - **Data Access Tab**
   - **Data Objects Sub-tab**
   - **Merge Button**

2. The Available Objects dialogue box will open.

   ![Available Objects Dialogue Box](Image)

   - **Available Objects**
   - **Select two or more qualified dimensions to be merged**
3. Holding down the control key on the keyboard, click on the first objects to be merged.

4. Click **OK**.

5. Repeat until all fields are merged.
6. Merged dimensions will display as a dimension under **Available Objects**.
To display the merged dimension in a report first add report to the document. Add a report by right clicking on the **Report 1** tab, at the bottom of the report, and selecting **Add Report**.

An empty report will open and an additional report tab will be added.
Select the merged dimensions to be displayed by holding the control key and selecting them in the order to be displayed.
Drag the selected items into the empty report to display the results.

<table>
<thead>
<tr>
<th>Biennium</th>
<th>GL Account</th>
<th>Program</th>
<th>Amount</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>2015</td>
<td>6505</td>
<td>010</td>
<td>-25,076.6</td>
<td></td>
</tr>
<tr>
<td>2015</td>
<td>6505</td>
<td>030</td>
<td>5,449,342.26</td>
<td></td>
</tr>
<tr>
<td>2015</td>
<td>6505</td>
<td>040</td>
<td>3,171,930.77</td>
<td></td>
</tr>
<tr>
<td>2015</td>
<td>6505</td>
<td>060</td>
<td>1,082,525.24</td>
<td></td>
</tr>
<tr>
<td>2016</td>
<td>6610</td>
<td>010</td>
<td>24,208,113.35</td>
<td></td>
</tr>
<tr>
<td>2015</td>
<td>6510</td>
<td>030</td>
<td>39,632,493.51</td>
<td></td>
</tr>
<tr>
<td>2015</td>
<td>6510</td>
<td>040</td>
<td>45,170,808.74</td>
<td></td>
</tr>
<tr>
<td>2015</td>
<td>6510</td>
<td>060</td>
<td>8,372,954.32</td>
<td></td>
</tr>
<tr>
<td>2017</td>
<td>6505</td>
<td>010</td>
<td>603,569.47</td>
<td></td>
</tr>
<tr>
<td>2017</td>
<td>6505</td>
<td>030</td>
<td>3,819,610.11</td>
<td></td>
</tr>
<tr>
<td>2017</td>
<td>6505</td>
<td>040</td>
<td>1,256,804.33</td>
<td></td>
</tr>
<tr>
<td>2017</td>
<td>6505</td>
<td>060</td>
<td>480,051.34</td>
<td></td>
</tr>
<tr>
<td>2017</td>
<td>6505</td>
<td>080</td>
<td>1,905,471.67</td>
<td></td>
</tr>
<tr>
<td>2017</td>
<td>6505</td>
<td>090</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To see a single amount column a formula would need to written summing the two amounts.

- An example would be =\([2013].[Amount]+[2011].[Amount]\)
Chapter 10

Printing and Exporting Reports
Reports can be printed by clicking on the **Print** icon located on the **File** tab.
When the **Print** icon clicked the **Print** dialogue box displays. Set the print options and click **OK**.
1. To export a report click on the dropdown arrow next to the **Save** icon and select **Save as**.
2. When **Save as** is clicked the **Save** dialogue box displays. Select **My Desktop**, **My Documents**, or **My Computer** as the location.
3. Verify the file name and update if needed.
4. Select the file type.
5. Click **Save**.
Chapter 11

Scheduling Reports
Scheduling Reports

Web Intelligence reports can be scheduled to run on a recurring schedule.

1. On the **Documents** tab, locate and select the object that to be scheduled.
2. Right click
3. Select “**Schedule**”
4. The schedule Dialogue will open.
5. In the **Instance Title** box, type a name for the instance.

6. In the "Schedule" dialog box, click Recurrence

7. Choose one of the recurrence options from the **Run object** list and set the required options. The default is “Now”.

   **The following additional options are available:**
   - **Once**
     This option requires a start and end time parameter. The object runs once at the time that you specify. If you schedule the object with events, the object will run once if the event is triggered between the start and end times.
   - **Hourly**
     This option requires information in hours and/or minutes for how frequently the object is run. Instances are created regularly to match the parameters that you enter. The first instance is created at the start time that you specify, and the object will cease to run on its hourly schedule at the end time that you specify.
   - **Daily**
     This option requires a start and end time parameter. The object runs once every N days at the time that you specify. It will not be run after the end time that you specify.
• **Weekly**
  This option requires a start and end time parameter. Each week, the object runs on the selected days at the time that you specify. It will not be run after the end time that you specify.

• **Monthly**
  This option requires a start date and time, along with a recurrence interval in months. The object runs on the specified date and time every N months. It will not be run after the end time that you specify.

• **Nth Day of Month**
  This option requires a day of the month on which the object is run. Instances are created regularly each month on the day that you enter at the start time that you specify. The object will not be run after the end time that you specify.

• **1st Monday of Month**
  This option requires a start and end time parameter. An instance is created on the first Monday of each month at the time that you specify. The object will not be run after the end time that you specify.

• **Last Day of Month**
  This option requires a start and end time parameter. An instance is created on the last day of each month at the time that you specify. The object will not be run after the end time that you specify.

• **X Day of Nth Week of the Month**
  This option requires a start and end time parameter. An instance is created monthly on a day of a week that you specify. The object will not be run after the end time that you specify.

• **Calendar**
  This option allows you to select a calendar of dates. (Calendars are customized lists of schedule dates that are created by the Bi platform administrator.) An instance is created on each day that is indicated in the calendar, beginning at the start time that you specify and continuing until the end time that you specify.
8. Click **Formats**
9. Select the format you want to schedule to from the Output Format list.
10. Click **Destinations**
   a) Select a destination option
   b) Select the **Keep an instance in the history** check box if you want to save a copy of the instance.
   c) Select the **Use default settings** check box if you want to the report to be sent to the logged in user.

You can schedule to the following destination locations:

- **Default Enterprise Location**
  If you select this option, the instance is saved within Business Objects.

- **BI Inbox**
  This option saves the instance to BI Inboxes specified.

- **Email**
  This option sends the instance to the specified email recipients.

- **FTP Server**
  This option saves the instance to the specified FTP server.

- **File System**
  This option saves the instance to the specified file location.

11. Click **Schedule**
To log off click the **Log Off** button.
Questions